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Zetadocs Expenses Integration Setup Guide

 
This guide aims to provide you with all the information you need to get a Zetadocs

Expenses system integrated with your accounting software. Much of the install will be

done for you by a representative of our technical team, please contact your Reseller if you

need further information on the requirements or scheduling of the installation.

Setting up Zetadocs Expenses integration has three main stages:

1. Preparing your Environment: Before installing the integration components on your

system there are a number of setup steps that should be completed. These include

configuring the Zetadocs Expenses Account, configuring your Microsoft Dynamics

software and preparing your network for integration with Zetadocs Expenses.

2. Zetadocs Expenses Extension for Business Central: Use the Zetadocs Expenses

Extension for Business Central to connect Zetadocs Expenses to Microsoft Dynamics 365

Business Central when deployed in the cloud.

3. Zetadocs Expenses Extension for Business Central on Premises: Use the Zetadocs

Expenses Extension for Business Central to connect Zetadocs Expenses to Microsoft

Dynamics 365 Business Central when deployed on premises.

4. Zetadocs Expenses Connector for NAV: Use the Zetadocs Expenses Connector for

NAV to connect Zetadocs Expenses to Microsoft Dynamics NAV. It is an proprietary

service application that must to be installed on the NAV server machine.

5. Testing the Setup: Verifying that the setup is complete and correct is an important

final step in the setup. 

For technical support, visit the Equisys support pages, www.equisys.com/support
Published 6th November 2019

http://www.equisys.com/support
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Preparing your Environment

As the first step of the setup process a couple of basic steps must be completed in order

to prepare your system and accounting software for integration with Zetadocs Expenses.

1. Checking the Firewall Settings

2. Registering your Account

3. Configuring Zetadocs Expenses
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Checking the Firewall Settings

Your firewall settings requirements will depend on how you have deployed Business

Central and NAV:

· Business Central public cloud – No firewall changes or connector installation required

· Business Central private cloud or on premises – Firewall changes required, no

connector installation required

· NAV private cloud or on premises – No firewall changes required, connector installation

required

Business Central private cloud or on premises requirements
Firewall changes are required to publish the Zetadocs Expenses Web Service for external

communication via HTTPS. See advice from your Reseller or firewall maintainer on

making the Zetadocs Expenses Web Service Internet facing and applying the correct

certificates to enable HTTPS communications.

NAV private cloud or on premises requirements
The Zetadocs Expenses Connector makes it easy to setup secure access to your data using

the Microsoft Azure Service Bus Relay. This service allows the Zetadocs Expenses

Connector make outbound calls to establish a connection with Zetadocs Expenses. This

reduces the amount of firewall configuration required. The connector can communicate

using either HTTP/HTTPS connections using ports 80 and 443 as per normal web traffic,

however you will gain a significant performance increase if you allow Zetadocs to use

outgoing TCP to communicate with the Service Bus relay.

Firewall Requirements
The following Ports need to be open to enable communication with the Zetadocs

Expenses site and the service bus relay. 

· Port 80 

· Port 443 

Optional Firewall Changes - Utilizing TCP
Using outgoing TCP to communicate with the Service Bus relay will provide you with a

quicker more responsive solution. To support this you will need to open ports 9350,

9351, 9352, 9353 and 9354 whilst also ensuring that the connector has been set to run as

a user with sufficient authority to utilize these ports.
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Further Advice
Further advice is available from Microsoft via the links below.

   

Connection Requirements

Due to the variety and complexity of network Firewall and proxy setups it is difficult to

provide specific steps for all requirements, beyond those provided above. The link below

provides the latest information from Microsoft on how to connect to the Service Bus from

behind a Firewall or a proxy server whilst maintaining security.  

https://azure.microsoft.com/en-us/documentation/articles/service-bus-architecture/

Troubleshooting your Connection

Should you have problems establishing a reliable connection to the Service Bus Microsoft

has provided tools and advice on how to troubleshoot your connection. Simply follow the

link below and review the latest advice.

http://social.technet.microsoft.com/wiki/contents/articles/2055.troubleshooting-

connectivity-issues-in-the-windows-azure-appfabric-service-bus.aspx

Understanding the Connection Requirements
Zetadocs Expenses Connector is installed behind the firewall and only requires Internet

access to communicate with the Zetadocs Expenses site. Once users can access the

Zetadocs Expenses website the Expenses site needs access to data on premise so it can

display the appropriate data to those authenticated users. 

The Azure Service Bus is designed to broker calls between the Expenses site and the on

premise Expenses Connector via a secure encrypted HTTPS channel. As both the Expenses

site and the on premise Expenses Connector only make outbound calls to the Service Bus,

no inbound firewall changes are required. The Expenses Connector is then configured to

communicate with Microsoft Dynamics NAV via business web services to provide users

with access to the essential NAV data.

https://azure.microsoft.com/en-us/documentation/articles/service-bus-architecture/
http://social.technet.microsoft.com/wiki/contents/articles/2055.troubleshooting-connectivity-issues-in-the-windows-azure-appfabric-service-bus.aspx
http://social.technet.microsoft.com/wiki/contents/articles/2055.troubleshooting-connectivity-issues-in-the-windows-azure-appfabric-service-bus.aspx
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Registering your Account

When you request a Zetadocs Expenses account for your company you will be sent an

Account Registration email from the Zetadocs Expenses team. This email contains a

Complete Registration link, it is used to activate your Account and allow you to access the

system and complete the remaining setup steps.

This email will be sent from approvals@noreply.mail.zetadocs.com, should you not

receive your registration email as expected please check your spam filter settings before

raising a support request. This email address will also be used to send approval request

notifications and reminders, as such it should be added to your list of safe or trusted

senders to ensure that users throughout your organization receive Zetadocs Expenses

emails.

Completing the registration requires the selection of some key account settings which

cannot be changed later. If you are unsure of any of these settings then it is advised that

you wait for the Zetadocs team member to assist you in this setup step.

1. Open the email and select the Complete Registration button. 

2. You will be taken to the Zetadocs Expenses site where you need to enter details about

your account as well as your First and Last Names and chosen password. It is

important to check the Account Name and email address fields before clicking

Register.  

3. This will complete your account registration and display a confirmation screen which

contains the Secure Connection Credentials for your Account. These should be copied

to a safe location as they will be required to establish the connection between Zetadocs

Expenses and your internal systems.

mailto:approvals@noreply.mail.zetadocs.com
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Configuring Zetadocs Expenses

Configuration Process:

At present the configuration of Zetadocs Expenses is carried out by a member of the

Zetadocs team and should have been arranged when you requested your system. 

They will assist you in configuring the system with essential information required to

successfully integrate with your accounts system. This will include:

1. Regional Settings

2. Companies

3. Users

4. Export Settings

5. Payment Methods

6. Expense Types

7. Currencies

8. Vehicle Types

9. Sales Tax 
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Zetadocs Expenses Connection Setup

The next step is to setup the connection type in Zetadocs Expenses:

1. Log into the Zetadocs Expenses System Settings using the Administrator account

2. Click on the “Export Settings”

3. Set “ERP Integration” to “Enabled”

4. Set “ERP System Type” to “Dynamics 365 Business Central / NAV”

5. Set Report Export and Export Description Format to Automatic.

6. Click Save.

Continue below if you are connecting to Business Central or skip to Zetadocs Expenses

Connector if connecting to NAV.
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Zetadocs Expenses Extension for Business Central

Use the Zetadocs Expenses Extension for Business Central to connect Zetadocs Expenses

to Microsoft Dynamics 365 Business Central when deployed in the cloud.

Steps to set up the Zetadocs Expenses Extension for Business Central:

1. Install the Zetadocs Expenses app

2. Run the Zetadocs Expenses Assisted Setup

3. Create Web Service Key

4. Testing the export to Business Central
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Install the Zetadocs Expenses App

· Zetadocs Expenses is available for installation via AppSource of the Extension

Marketplace option under Manage, from the Setup & Extensions > Extensions

Command bar.

· Confirm your Language on the Extension Installation page and hit Install.
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Run the Zetadocs Expenses Assisted Setup

· From the Command bar, choose Setup & Extensions > Assisted Setup and click on Set

up Zetadocs Expenses connection. 

· Follow the instructions presented during the assisted setup and keep a note of the

Zetadocs Expenses web service URL as you’ll need that in a moment. NOTE: Only part of

the URL is displayed https://api.businesscentral.dynamics.com/v1.0/edd93260-083e-

4957-9438-1cd27da1... however, copying the URL will copy the entire URL e.g.

https://api.businesscentral.dynamics.com/v1.0/edd93260-083e-4957-9438-

1cd27da175e7/sandbox/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses 

https://api.businesscentral.dynamics.com/v1.0/edd93260-083e-4957-9438-1cd27da1
https://api.businesscentral.dynamics.com/v1.0/edd93260-083e-4957-9438-1cd27da1
https://api.businesscentral.dynamics.com/v1.0/edd93260-083e-4957-9438-1cd27da175e7/sandbox/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses
https://api.businesscentral.dynamics.com/v1.0/edd93260-083e-4957-9438-1cd27da175e7/sandbox/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses
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Create Web Service Key

· From the Command bar, choose Setup & Extensions > Manual Setup and click on Users.

· Normally the web service user will be the same Accounts Payables user that will

perform the export of approved expense reports from the Zetadocs Expenses cloud

service.

· For AppSource testing, edit the current logged in user from the user list and choose

Change Web Service Key from the Authentication ribbon.

· Click Yes on the warning and choose Key Never Expires, on the next screen and click OK.

· Make a note of the Web Service Access Key created.

Zetadocs Expenses Web Service Configuration

Go to https://expenses.zetadocs.com/Settings and Sign In as a user with the Zetadocs

Administrator role.

· Click on the Companies tab and choose the Manage icon to the right of your company

name. 

· Set the following information under Connection:

Web Service

Type:     

Zetadocs Extension for Business Central

Web Service

URL:     

<enter the web service URL created above. You can rerun the

Zetadocs Expenses connection Assisted Setup again to retrieve the

URL if needed>

Web Service

User Name:     

<enter the user name you created the web service key above>

Web Service

Access Key:     

<enter the web service access key from above. Be sure to include

the trailing equals sign = > e.g.

V5M80zzkUfyYO9+fDLziyIDz0q7P33Hfj40APVydtRw=

· Now click Save.

You have now completed the connection to Business Central and you can go directly to

Testing the Setup section next.

https://expenses.zetadocs.com/Settings
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Zetadocs Expenses Extension for Business Central on

Premises

Use the Zetadocs Expenses Extension for Business Central to connect Zetadocs Expenses

to Microsoft Dynamics 365 Business Central when deployed on premises.

Assumptions:

1. Internet facing web services have been configured with a genuine certificate issued by

a Certificate Authority

NOTE: Self-signed certificates are not supported by Zetadocs Expenses

2.  Firewall settings that allow SOAP port (typically 7047) calls through to Business

Central web services unrestricted

3. DNS entries have been created for the fully qualified domain name (FQDN) that

corresponds to the server certificate name e.g. https://bcserver.domain.com

Steps to set up the Zetadocs Expenses Extension for Business Central on premises:

1. Publishing the Extension app file

2. Installing the Extension

3. Run the Zetadocs Expenses Assisted Setup

4. Enabling access to the Web Services

5. Testing the Zetadocs Expenses Web Service

6. Configure the Zetadocs Expenses to use the published Web Service

7. Testing the Export to Business Central

https://bcserver.domain.com
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Publishing the Extension app file

1. Ensure you have the latest [Zetadocs Expenses Extension] .app file for your version of

Business Central.

2. Use the below script in Business Central Administration Shell (update the values in bold

below to match your server instance and the Zetadocs Expenses Extension for your

version of Business Central.)

Publish-NavApp -serverInstance BC140 -path 'Zetadocs

Expenses_1.2.5.14_runtime.app' -skipVerification -packageType Extension
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Installing the Extension

1. Go to the Extension Management page in the Business Central web client

2. Select “Zetadocs Expenses” and click on Install

3. Click Next and select the relevant language

4. Accept the terms and conditions and click on Install
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Run the Zetadocs Expenses Assisted Setup

1. Go to Assisted Setup in the Business Central web client

2. Follow the "Set up Zetadocs Expenses connection" Assisted Setup to publish the web

service

3. Take a note of the web service URL
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Enabling Access to the Web Service

1. Go to Users and select a user with SUPER permissions

2. Click on the three dots of the Web Service Access Key, then “Yes”. Tick the Key Never

Expires box and then click on OK

3. Copy the Web Service Access Key
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Testing the Zetadocs Expenses Web Service

1. Test access to the web service by opening the web service URL in a browser on a PC

outside your internal network and entering the relevant Business Central user name

and the web service key e.g.

https://<your_internet_facing_domain>/WS/CRONUS%20UK%

20Ltd./Codeunit/ZetadocsExpenses

<YOUR_DOMAIN>\<WEBSERVICE_USER>

<WEB_SERVICE_KEY>

e.g. 

https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%

20Ltd./Codeunit/ZetadocsExpensesBCSERVER\WSUSERrDkv+s92fd/e9dfAk+xyfG

NhXfBTz2m2b/vL7L6Y/NI= 

2. If everything is setup correctly you should see a response from the webservice similar

to this….

This XML file does not appear to have any style information associated with it. The

document tree is shown below.

<definitions xmlns="http://schemas.xmlsoap.org/wsdl/" xmlns:tns="urn:microsoft-

dynamics-schemas/codeunit/ZetadocsExpenses"

targetNamespace="urn:microsoft-dynamics-

schemas/codeunit/ZetadocsExpenses">

<types>

<schema xmlns="http://www.w3.org/2001/XMLSchema"

elementFormDefault="qualified" targetNamespace="urn:microsoft-dynamics-

schemas/codeunit/ZetadocsExpenses">

<element name="ExportExpenses">

<complexType>

<sequence>

<element minOccurs="1" maxOccurs="1" name="data" type="string"/>

<element minOccurs="1" maxOccurs="1" name="resultData" type="string"/>

</sequence>

</complexType>

</element>

<element name="ExportExpenses_Result">

https://<your_internet_facing_domain>/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses
https://<your_internet_facing_domain>/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses
https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpensesBCSERVER\WSUSERrDkv+s92fd/e9dfAk+xyfGNhXfBTz2m2b/vL7L6Y/NI=
https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpensesBCSERVER\WSUSERrDkv+s92fd/e9dfAk+xyfGNhXfBTz2m2b/vL7L6Y/NI=
https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpensesBCSERVER\WSUSERrDkv+s92fd/e9dfAk+xyfGNhXfBTz2m2b/vL7L6Y/NI=
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<complexType>

<sequence>

<element minOccurs="1" maxOccurs="1" name="return_value" type="int"/>

<element minOccurs="1" maxOccurs="1" name="resultData" type="string"/>

</sequence>

</complexType>

</element>

<element name="GetExtensionFullVersion">

<complexType>

<sequence/>

</complexType>

</element>

<element name="GetExtensionFullVersion_Result">

<complexType>

<sequence>

<element minOccurs="1" maxOccurs="1" name="return_value" type="string"/>

</sequence>

</complexType>

</element>

</schema>

</types>

<message name="ExportExpenses">

<part name="parameters" element="tns:ExportExpenses"/>

</message>

<message name="ExportExpenses_Result">

<part name="parameters" element="tns:ExportExpenses_Result"/>

</message>

<message name="GetExtensionFullVersion">

<part name="parameters" element="tns:GetExtensionFullVersion"/>

</message>

<message name="GetExtensionFullVersion_Result">

<part name="parameters" element="tns:GetExtensionFullVersion_Result"/>

</message>

<portType name="ZetadocsExpenses_Port">

<operation name="ExportExpenses">

<input name="ExportExpenses" message="tns:ExportExpenses"/>

<output name="ExportExpenses_Result" message="tns:ExportExpenses_Result"/>

</operation>

<operation name="GetExtensionFullVersion">
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<input name="GetExtensionFullVersion"

message="tns:GetExtensionFullVersion"/>

<output name="GetExtensionFullVersion_Result"

message="tns:GetExtensionFullVersion_Result"/>

</operation>

</portType>

<binding name="ZetadocsExpenses_Binding" type="tns:ZetadocsExpenses_Port">

<binding xmlns="http://schemas.xmlsoap.org/wsdl/soap/"

transport="http://schemas.xmlsoap.org/soap/http"/>

<operation name="ExportExpenses">

<operation xmlns="http://schemas.xmlsoap.org/wsdl/soap/"

soapAction="urn:microsoft-dynamics-

schemas/codeunit/ZetadocsExpenses:ExportExpenses" style="document"/>

<input name="ExportExpenses">

<body xmlns="http://schemas.xmlsoap.org/wsdl/soap/" use="literal"/>

</input>

<output name="ExportExpenses_Result">

<body xmlns="http://schemas.xmlsoap.org/wsdl/soap/" use="literal"/>

</output>

</operation>

<operation name="GetExtensionFullVersion">

<operation xmlns="http://schemas.xmlsoap.org/wsdl/soap/"

soapAction="urn:microsoft-dynamics-

schemas/codeunit/ZetadocsExpenses:GetExtensionFullVersion"

style="document"/>

<input name="GetExtensionFullVersion">

<body xmlns="http://schemas.xmlsoap.org/wsdl/soap/" use="literal"/>

</input>

<output name="GetExtensionFullVersion_Result">

<body xmlns="http://schemas.xmlsoap.org/wsdl/soap/" use="literal"/>

</output>

</operation>

</binding>

<service name="ZetadocsExpenses">

<port name="ZetadocsExpenses_Port" binding="tns:ZetadocsExpenses_Binding">

<address xmlns="http://schemas.xmlsoap.org/wsdl/soap/"

location="https://api.businesscentral.dynamics.com/v2.0/dc228d65-da29-4961-

9a0c-ad9450345289/Production/WS/CRONUS%20UK%

20Ltd./Codeunit/ZetadocsExpenses?tenant=msweua9310t57459082&aid=FIN"/>

</port>
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</service>

</definitions>

3. If not, then please reconfirm the Assumptions at the beginning of this topic are true

and confirm you are entering the access credentials in the format above before

continuing.
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Configure Zetadocs Expenses to use the published

Web Service

1. Go to Companies and click Manage to enter the Company Details page

2. Choose Zetadocs Expenses Extension for Business Central as the web service type

3. Enter the web service URL, ensuring this the https and FQDN is amended to the start of

the one you copied after the Assisted Setup

e.g. https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%

20Ltd./Codeunit/ZetadocsExpenses 

4. Enter the web service user and key e.g.

DEMOBOX\SALESTEAM\rEkv+s82fd/b9dfAk+xyqGNhXfMTz2m2b/vL7L6Y/NI=

5. Save your settings

https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses
https://bcserver.domain.com:7047/BC140/WS/CRONUS%20UK%20Ltd./Codeunit/ZetadocsExpenses


26 Zetadocs Expenses Integration Setup Guide

Copyright © Equisys Ltd

Testing the Export to Business Central

1. Prepare an expense report and send it for approval

2. Confirm the export succeeded.
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Zetadocs Expenses Connector for NAV

Use the Zetadocs Expenses Connector for NAV to connect Zetadocs Expenses to Microsoft

Dynamics NAV. It is an proprietary service application that must to be installed on the

NAV server machine.

Steps to set up the Zetadocs Expenses Connector:

1. Connector Setup Pre-requisites

2. Creating the Connector User Account

3. Opening the Web Services

4. Linking your Connector and the Zetadocs Expenses Service

5. Starting the Connector Service

6. Testing the Connection
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Connector Setup Pre-requisites

Please note that the Zetadocs Expenses Connector requires the following files to be

installed. 

Please Note: .NET 4.5 is a pre-requisite for NAV 2013 and above and will already be

installed on machines running it, as such if you are installing the connector on a machine

running NAV 2013 and above you can skip this section.

.NET 4.5

.NET 4.5 or later is required for the Connector, if you are unsure whether your system has

it installed please follow the steps below. 

1. Locate your Zetadocs Expenses Connector download and extract it in a suitable

location.

2. Next locate the NDP451-KB2858728-x86-x64-AllOS-ENU.exe file and run it to install

.NET4.5.

3. If you are already using this or a higher version of .NET a message will appear, in

which case you can cancel the install. 

4. Otherwise follow the installers instructions to complete the .NET 4.5 install. 
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Creating the Connector User Account

The Zetadocs Expenses Connector needs to be setup and running to enable a connection

between your NAV system and the Zetadocs Expenses service, to do this it is

recommended that the connector is configured to run as its own user on both your

network and in NAV. 

Creating a Windows User for the Connector
You need to create a specific user account for the connector, which has the permissions

required to access the internet making use of the firewall settings configured earlier to

allow it to reach Zetadocs Expenses service. This should be done as per your standard

network user generation policy.

Creating a NAV user for the Connector (NAV 2013 and above)
1. Open the NAV Windows Client (RTC). 

2. In the search bar, search for Users and open the Users page. 

3. Click the New button and add a User Name and Full Name of Connector.

4. Select the License Type drop down menu and select Limited User.

5. Next in the Windows Authentication section select the Windows User Name option

and select the Windows user account you created above and click OK.

Creating a NAV user for the Connector (NAV 2009 R2)
1. Open the NAV Classic Client and select Tools, Security and then Windows Logins. 

2. Add the Connector user you created above. 
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Setting up Roles and Permissions

To enable the Zetadocs Expenses to connect to Microsoft Dynamics NAV systems a set of

roles and permissions need to be configured for it. This section covers the setup of roles

and permissions in NAV required for integrating Zetadocs Expenses.

Required Permission Sets

To enable the Zetadocs Expenses Connector service to function correctly the user that the

service is running as needs to have the following permission sets:

· BASIC – This gives basic access to the NAV system (NAV 2013 and above only)

· ALL – This gives basic access to the NAV system (NAV 2009 R2)

· ZETADOCS – Provides access to the Zetadocs for NAV functionality for related

documents.  Please see your product specific  installation guide for more information

on creating this permission set.

· ZETADOCSAPPROVALS – Provides access to the standard NAV tables required by the

Zetadocs Expenses Connector.

The process for configuring NAV varies depending on the version of NAV you are using:

· Microsoft Dynamics NAV 2013 and above Systems

· Microsoft Dynamics NAV 2009 R2 Systems

Configuring the Zetadocs Approval Permissions Set for NAV 2013

and above
Permissions are setup using a rapid start file that is part of the product download.

Importing the RAPIDSTART file

The ZETADOCSAPPROVAL role grants access to the specific tables that Zetadocs Expenses

requires access to. Please follow the steps below to import the RAPIDSTART file:

1. Open the NAV Windows Client (RTC). 

2. In the search bar, search for Configuration Packages and open the Configuration

Packages page. 

3. Select Import Package… from the Process group on the Home tab and select the

Zetadocs Approval Permission Sets and Permissions.RAPIDSTART file from your

product download. 

4. In the Process group, click on Apply Package to complete import of the settings.

5. Next type Users into the search bar and open the Users page.

6. Select the Connector user and open the user card.
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7. In the User Permission Sets section add the ZETADOCS  permission set and click OK.

8. In the User Permission Sets section add the ZETADOCSAPPROVALS  permission set

and click OK.

9. We also recommend the following standard NAV permissions be granted to the

Connector which should enable it to work on standard systems. 

Permission Sets 

· BASIC

· P&P-Q/O/I/R/C 

· P&P-Q/O/I/R/C, POST 

· P&P-VENDOR 

· G/L-JOURNAL

· G/L-JOURNAL, POST

· JOB-JOBS

· JOB-JOURNAL

· JOB-JOURNAL, POST

Please Note: If you have modifications in NAV on data access by Expenses which require

extra or modified permissions for users to access and work with them, then please grant

these permissions to the Connector user as well.

Configuring the Zetadocs Approval Permissions Set for NAV 2009 R2
The Zetadocs Expenses Connector comes with two xml files which contain the permission

set (formally known as a role) and permissions. To import these settings please follow the

steps below:

Permission Set

1. Open the NAV Classic Client.

2. From the navigation pane select Administration Application Setup > Company Setup >

Data Migration.

3. The Migration Overview form will appear, select the Functions button and then Import

from XML.

4. Go to your product download folder and open the Zetadocs Approval Permission

Set.xml file. 

5. When the import is complete return to the Migration Overview form, highlight the row

containing the imported Role and select the Migration button and then choose the

Apply Migration Data option.

Permissions

1. Open the Dynamics NAV Classic Client.
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2. From the navigation pane select Administration > Application Setup > Company Setup

> Data Migration.

3. The Migration Overview form will appear, select the Functions button and then Import

from XML.

4. Go to your product download folder and open the Zetadocs Approval Permissions.xml

file.

5. When the import is complete return to the Migration Overview form, highlight the row

containing the imported Permissions and select the Migration button and then choose

the Apply Migration Data option.

Note: After the “Apply Migration Data” you need to initiate the execution of the

synchronization process “Synchronize All Logins”.

Allocating the Permissions to the Connector User

1. Open the NAV Classic Client and select Tools, Security and then Windows Logins.

2. Choose the Connector user and click the Roles button.

3. Select the Roles ID column and choose ZETADOCSAPPROVALS and click OK.

4. If you are using Zetadocs Capture as well as Approval add the ZETADOCSEXPRESS

permission set as well.

5. We also recommend the following standard NAV permissions be granted to the

Connector which should enable it to work on standard systems. 

Permission Sets 

· BASIC

· P&P-Q/O/I/R/C 

· P&P-Q/O/I/R/C, POST 

· P&P-VENDOR 

· G/L-JOURNAL

· G/L-JOURNAL, POST

· JOB-JOBS

· JOB-JOURNAL

· JOB-JOURNAL, POST

Please Note: If you have modifications in NAV on the areas accessed by Approvals, which

require extra or modified permissions for users to access and work with them, then

please grant these permissions to the Connector user as well.
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Opening the Web Services

To enable Zetadocs Expenses to access data from your NAV system you need to publish a

series of web services which enable a connection to be established. The web services use

a combination of NAV objects and add-in Dlls to support the various calls from the

Zetadocs Expenses service.

Installing the Integration Add-in Dll for NAV 2013 and above
To compile the NAV objects that you will import in the next step you must install the

integration components in the local RTC add-ins folder. For the web services to run

successfully at runtime later the dll must also be installed in the Microsoft Dynamics NAV

services add-in folder. 

Installing the Add-in Dll for object compilation

1. On the system where you will import the objects using the Microsoft Dynamics NAV

Developer Environment, navigate to the RTC add-ins folder. This is typically found at 

a. C:\Program Files (x86)\Microsoft Dynamics NAV\100\RoleTailored Client\Add-ins

2. Create a new folder "Zetadocs Expenses"

3. Copy the Zetadocs.Approval.Integration.dll from the <Zetadocs Expenses download

pack>\Zetadocs Expenses NAV Server Extensions to this folder

Installing the Add-in Dll for runtime

4. On the system where your Microsoft Dynamics NAV Server service is installed,

navigate to the service add-ins folder. This is typically found at 

a. C:\Program Files\Microsoft Dynamics NAV\100\Service\Add-ins

5. Create a new folder "Zetadocs Expenses"

6. Copy the Zetadocs.Approval.Integration.dll from the <Zetadocs Expenses download

pack>\Zetadocs Expenses NAV Server Extensions to this folder

7. Now restart the Microsoft Dynamics Nav Service. 

Installing the Integration Add-in Dll for NAV 2009 R2
To compile the NAV objects that you will import in the next step you must install the

integration components in the local RTC and Classic add-ins folder. For the web services

to run successfully at runtime later the dll must also be installed in the Microsoft

Dynamics NAV services add-in folder. 
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Installing the Add-in Dll for object compilation

1. On the system where you will import the objects using the Microsoft Dynamics NAV

Classic Client, navigate to the RTC add-ins folder. This is typically found at 

a. C:\Program Files (x86)\Microsoft Dynamics NAV\60\RoleTailored Client\Add-ins

2. Create a new folder "Zetadocs Expenses"

3. Copy the Zetadocs.Approval.Integration.dll from the <Zetadocs Expenses download

pack>\Zetadocs Expenses NAV Server Extensions to this folder

4. Perform steps 1 to 3 for the add-ins folder for the Classic Client. This is typically found

at

a. C:\Program Files (x86)\Microsoft Dynamics NAV\60\Classic\Add-ins

Installing the Add-in Dll for runtime

5. On the system where your Microsoft Dynamics NAV Server service is installed,

navigate to the service add-ins folder. This is typically found at 

a. C:\Program Files (x86)\Microsoft Dynamics NAV\60\Service\Add-ins

6. Create a new folder "Zetadocs Expenses"

7. Copy the Zetadocs.Approval.Integration.dll from the <Zetadocs Expenses download

pack>\Zetadocs Expenses NAV Server Extensions to this folder

8. Now restart the Microsoft Dynamics Nav Business Web Services Service. 

Importing the Objects
9. Start the NAV Development Environment (NAV Classic Client in NAV 2009 R2) and

open the Object Designer.

10.Select File and then Import. Browse to the NAV Objects folder in the Zetadocs

Expenses download pack:

a. For NA (North America) database with NAV 2009 R2, select the "Zetadocs Expenses

Objects - NA (NAV 6.10).fob" file.

b. For NA (North America) database with NAV 2013 or later, select the "Zetadocs

Expenses Objects - NA (NAV 7.00+).fob" file.

c. For UK (United Kingdom) or GB (Great Britain) database with NAV 2009 R2, select

the "Zetadocs Expenses Objects - UK (NAV 6.10).fob" file 

d. For UK (United Kingdom) or GB (Great Britain) database with NAV 2013 or later,

select the "Zetadocs Expenses Objects - UK (NAV 7.00).fob" file 

NOTE: you may need to recompile the newly imported NAV objects after import. To do

this, apply a "Version" field filter on "ALL" objects of "ZDA*". Then select all objects and hit

F11.

11.Next go to the NAV Role Tailored Client and open the Web Services, click New and add

each of the following entries ensuring that they are named exactly as specified below. 
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Object Type Object ID Service Name Published

CodeUnit 9041228 ApprovalManagement X

Codeunit 9009987 Expenses X

To test that these web services are published and available you can try and access them

using a web browser by adding the link to the web service. Ensure that SOAP services

have been enabled for the NAV Service in the NAV Administration program (for NAV

2009 R2, the SOAP services are enabled once the 'Microsoft Dynamics Business Web

Services' service is started. For the ApprovalManagement Codeunit this would take the

form:

http://<Server>:<WebServicePort>/<ServerInstance>/WS/<CompanyName>/CodeUnit/

ApprovalManagement. Example link:  http://localhost:7047/DynamicsNAV/WS/CRONUS

%20International%20Ltd/Codeunit/ApprovalManagement.

If successful you will be presented with the xml as shown below.

http://<Server>:<WebServicePort>/<ServerInstance>/WS/<CompanyName>/CodeUnit/ApprovalManagement
http://<Server>:<WebServicePort>/<ServerInstance>/WS/<CompanyName>/CodeUnit/ApprovalManagement
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Linking your Connector and the Zetadocs Expenses

Service

Zetadocs Expenses connects to Microsoft Dynamics NAV using the Zetadocs Expenses

Connector. This communicates with your systems and provides the ability to read and

write data for integrating Zetadocs Expenses with your accounting function. The setup of

the Zetadocs Expenses Connector is currently carried out by a member of the Zetadocs

team and should have been arranged when you requested your system.

Installing the Connector Components
1. Locate Setup.exe from the connector installation package (typically Zetadocs Expenses

Connector\Setup.exe). 

2. Run Setup.exe, this will require administrator privileges.

3. Select Next, accept the end user license agreement and click install. 

4. After successfully installing ensure the option to launch the Zetadocs Expenses

Connector Settings tool is checked and click Finish.

If for whatever reason the Zetadocs Expenses Connector Settings tool does not open;

open the start menu and run Zetadocs Expenses Connector Settings.

The tool should now be open as in the following picture:
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Understanding the Zetadocs Expenses Connector Settings Interface
The Zetadocs Expenses Connector Settings allows you to configure all of your accounts

and respective companies settings, so to enable the export to NAV functionality in

Expenses.

On the left-side panel are listed the configured accounts, under the machine’s root node.

Under each configured account are listed the respective companies. Through this

interface it’s possible to manage multiples accounts and their respective companies.

Managing Accounts

· View Details
To view the account’s details, select the node of the account which you wish view.

The account details panel will be displayed on the right-side panel. This right-side

panel will be divided in tabs which contain the various configuration options.

· Configuration Options

o Account Tab:
Account ID – The unique identifier of the account.

Account Display Name – The name that will be displayed on the left-side

panel for the selected account.

o Connection Tab:
Connection ID – The Connection ID provided in Zetadocs Expenses.
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Connection Public Key - The Connection Public Key provided in Zetadocs

Expenses.

o Connector Service Tab (read-only):
Connector Service Name – The service instance name assigned to the

account.

Connector Service User Name – The configured user to run the service

instance.

· Add Account
To add a new account first select the root node in the left-side panel and then click

the Add button, as illustrated in the image bellow.

A New Account will be added, and the configuration options will be available for

editing on the right-side panel.

To save the New Account, click the Save button.

To remove the New Account, the user can either move away from the New

Account selection on the left-side panel or click the Remove button.

· Edit Account
To edit an account, select it from the left-side panel, make the desired alterations to

its configuration and finally click the Save button to commit the changes.

· Remove Account
To remove an account, select it from the left-side panel, and click the Remove

button.

Managing Companies

· View Details
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To view a company’s details, select the node of the company which you wish view.

The company details panel will be displayed on the right-side panel. This right-side

panel will be divided in tabs which contain the various configuration options.

· Configuration Options

o Company Tab:
Company ID – The unique identifier of the company.

Company Display Name – The name that will be displayed on the left-

side panel for the selected company.

o NAV Services Tab:
NAV Zetadocs Approval Management Service – The web service URL

used to allow communication between Approvals and NAV.

NAV Zetadocs Expenses Service – The web service URL used to allow

communication between Expenses and NAV.

· Add Company
To add a new company first select an account’s node in the left-side panel and

then click the Add button, as illustrated in the image below.
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A New Company will be added, and the configuration options will be available for

editing on the right-side panel.

To save the New Company, click the Save button.

To remove the New Company, the user can either move away from the New

Company selection on the left-side panel or click the Remove button.

· Edit Company
To edit a company, select it from the left-side panel, make the desired alterations

to its configuration and finally click the Save button to commit the changes.

· Remove Company
To remove a company, select it from the left-side panel, and click the Remove

button.

Configuring the Connector Connection
Using the Zetadocs Expenses Connector Settings tool navigate to the Connection tab of

an Account.

1. The values for ConnectionID and ConnectionPublicKey were issued when you

registered your account, they are available in the Zetadocs Expenses Admin site under

the Export Settings tab.

2. In the Connection tab of the settings tool enter the Connection ID and the Connection

Public Key.

Configure the Service User
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Select the Connector Service tab of an Account, the user that the Zetadocs Expenses

Connector service is currently configured to run as is displayed in the Connector Service

User Name box.

Please:

1. Click the Configure button bellow the Connector Service User Name box. This should

open the Windows Services window. If for some reason it does not, press Windows

Key + R and type “services.msc” in the Run window

2. In the Windows Services window locate the Zetadocs Expenses Connector service

3. Right click on it and select Properties, then the Log On tab.

4. Enter the account details and password of the account you configured as a prerequisite

in Creating the Connector User Account.

5. Return to the Zetadocs Expenses Connector Settings tool.

6. Click the Refresh button in the Connector Service tab.

7. The user name will update to the user configured for the Zetadocs Expenses Connector

service to run as.

Configuring Companies
Expand the Account where the company to be configured is under. Once visible, select the

Company and navigate to the Company tab.

Please:

1. Choose a unique Company ID. This value must match the Name field configured for

the company in Expenses.

2. Define a Company Display Name. This value should match the Display Name field

configured for the company in Expenses for consistency.

To configure the options in the NAV Services tab please refer to the following sections of

this document.

Configuring Web Services for NAV 2013 and later
1. Open the NAV RTC then open the “Web Services” page. Copy the SOAP URL for the

ApprovalManagement service into the text box for NAV Zetadocs Approval

Management Service in the NAV Services tab of a Company.

2. Copy the SOAP URL from the “Web Services” page into the NAV Zetadocs Expenses

Service text box in the NAV Services tab of a Company.

Configuring Web Services for NAV 2009 R2
1. NAV 2009 R2 does not provide a quick view of the SOAP URL. In order to construct the

URL, follow the Microsoft documentation located at the following URL and follow the

instructions for codeunit web services: https://msdn.microsoft.com/en-
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us/library/dd355398.aspx (the 2 service names being ApprovalManagement, and

Expenses).

2. Copy the SOAP URL into the NAV Zetadocs Expenses Service text box in the NAV

Services tab of a Company.

Testing the connection to Web Services
To test the web services, click the Test button next to each text box. You will be prompted

for the credentials of the user configured in the service instance. Insert the credentials and

click the Ok button to test the connection.  If you see the "Connection test was successful"

prompt, you have successfully configured the service.

Understanding errors:

The remote server returned an error: (404) Not Found: The Zetadocs Expenses Connector

Settings tool could not establish communication with the server. Check the server

host name in the URL, verify if the server is running and is accessible.

The remote server returned an error: (500) Internal Server Error: The Zetadocs Expenses

Connector Settings tool established communication with the server, but the service

could not be accessed properly. Check if the last sections of the URL are spellt

correctly. Verify if the Codeunits/Pages have been published correctly.

The remote server returned an error: (401) Unauthorized: Wrong credentials entered.

Saving Settings
To save the configuration click on the Save button. When successful a restart of the

Zetadocs Expenses Connector services instances requires restart. To do this, navigate to

the Windows Services window by pressing the Windows Key + R and typing

“services.msc”, locate the Zetadocs Expenses Connector services, right click and select

Restart.
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Starting the Connector Service

Now that you have configured each of the individual elements of the Zetadocs Expenses

Connector configuration file you are ready to start the service.

1. Run View Local Services

2. Locate Zetadocs Expenses Connector

3. Start the service

Please note: The user must have sufficient rights to make outgoing data calls through

your firewall or proxy setup. We recommend creating a specific network user account for

this purpose. Prior to starting the connector it is advised to log in to the server hosting the

Zetadocs Expenses Connector and check internet access.

The connector should now be operational, if you have problems starting your connector

please review the Troubleshooting the Connection topic for more details.
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Testing the Connection

To test the connection between your NAV system and Zetadocs Expenses there are a few

quick checks you can make to ensure that the connection is securely established.

1. Did the connector start?

The Zetadocs Expenses connector runs a number of checks when you start it and if any

problems are detected it will fail to start. The Zetadocs Expenses Connector Log file will

contain information to point you towards a solution, please see the troubleshooting topic

for further details on interpreting and resolving these issues.
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Testing the Setup

Verifying that all the components are installed and configured correctly is an important

final step. Below are the main test steps that should be executed by your Zetadocs team

member during the installation session. 

Export Testing

1. Run a test approval and export for all Submitter users. Verify that the exports were

successful.

2. Run a test approval and export which includes one of each type of Expense Type.

3. Run a test approval and export for an expense which includes a non-taxable

amount.

Steps to follow

1. Log into Expenses with the administrator user of your account, go to the “System

Settings” screen and click on the “Payment Methods” tab

2. Click on the “Manage” arrow of the “Payment method” you wish to use, and set

“No” in the “Reimburse to User” menu

3. Set “Yes” in the “Enable ERP Export” menu

4. Set “Report Export” to “Manual”

5. To test exporting as Purchase Invoice: Set “NAV Vendor with Purchase Invoice”

in the “Export type” menu, and enter the correct “Vendor Number” 

6. To test exporting as a General Journal entry: Set “NAV Vendor with Journal” in

the “Export type” menu, and enter the correct “Vendor Number” 

7. Log into Expenses using the user with the role you are currently testing and open

the “Status” screen

8. Select the “Approved” report you wish to export to NAV, and click on the three-dot

menu in the top right corner of the screen, and select “Export to NAV”

9. The “Status” of the report should change in a few moments from “Approved” to

“Done”, to verify this click on the three-dot menu in the top right corner of the

screen and select “Refresh”

10. Once the “Status” of the report is “Done”, click on the report, the topmost entry in

the “History” section will indicate the number of the NAV Purchase Invoice or

Journal the report has been exported as
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11. To verify this, open the Microsoft Dynamics NAV Client. You can find the Purchase

Invoice or Journal you have just exported in either 

Departments > Financial Management > Payables > Purchase Invoices/Credit

Memos

or

Departments > Financial Management > General Ledger > General Journals

or

Departments > Jobs > Job G/L Journals
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Appendices

The following sections relate to actions which are optional or are not part of the standard

installation process.

Topics:

1. Troubleshooting the Zetadocs Expenses Connector
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Troubleshooting the Zetadocs Expenses Connector

Viewing the Connector Log File
The Zetadocs Expenses Connector has a log file which logs the connectors activity and

may prove useful in diagnosing any issues you are having. It can located at the following

location: C:\Users\<Username>\AppData\Local\Temp\Zetadocs where <Username>

represents the account under which the Connector is running. Select the

Zetadocs.Expenses.Connector.txt file and review the resent activity of your connector for

potential problems. 

To get additional logging information you should change the LogLevel specified in the

connector configuration file to "Debug" temporarily while troubleshooting issues. 

.NET 4 Framework Security Issue
Symptom: On starting the Connector the following error is displayed.

Resolution: This is due to a security issue associated with .NET 4.0, this can be resolved

by applying an update from Microsoft which can be downloaded from the following

Microsoft link:

http://support.microsoft.com/kb/2580188

NTLM Authentication Protocol Issue
Symptom: When running the connector you see the following error in the Zetadocs

Expenses Connector.log.

The HTTP request is unauthorized with client authentication scheme 'Anonymous'. The

authentication header received from the server was 'NTLM'.

Resolution: This issue only occurs when a network is using older NTLM authentication

protocols. Search your Connector Configuration file for the following text:

            <transport clientCredentialType="Windows" />

http://support.microsoft.com/kb/2580188
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Next replaced Windows with NTLM as shown below and save the file and restart your

Connector.

            <transport clientCredentialType="Ntlm" />



51Requesting Support

Copyright © Equisys Ltd

Requesting Support

Zetadocs Expenses comes with software assurance included as part of the service

agreement, however we recommend that all support requests are escalated through your

system administrator to the Resller who installed and setup the solution first. As they

have access to settings and options which may be able to resolve your inquiry more

swiftly.

Software Assurance
Software Assurance is our standard support contract, providing email support with a

response time of under 24 hours. Software Assurance enables administrators to keep

their systems up to date, including updates for new platforms and new versions of

supported applications, as well as feature enhancements in new releases.

When contacting Equisys for support please have the following information to hand: 

· Full description of the problem 

· Company name and administrator contact details

· Client PC operating system (e.g. Windows 7) 

· Contact phone number, address and email

Technical support in the United Kingdom
Tel: +44 (0)20 7203 4002 

Fax: +44 (0)20 7203 4007 

email: support@equisys.com 

Technical support in the United States
Tel: +1 (678) 942 7250 

Fax: +1 (770) 442 5789 

email: support@usa.equisys.com 

mailto:support@equisys.com
mailto:support@usa.equisys.com
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